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REFERAT
Dimensionering av dagvattenledningar med programmet Inroads Storm
& Sanitary
Camilla Hansen

Vid dimensionering av dagvattennät i Sverige görs i nuläget de flesta beräkningarna för hand.
Detta är ett tidskrävande arbete vid projektering där minsta förändring i nätets uppbyggnad
betyder att en mängd omberäkningar måste göras. De kommersiellt tillgängliga
hydrodynamiska modelleringsprogrammen som används inom Norden beräknar flöden på ett
alltför komplicerat och detaljerat sätt för dimensionering av enklare ledningsnät. De saknar
även en koppling till de vanligaste projekteringsprogrammen, samt saknar förmåga att återge
ledningsnäten i tre dimensioner.

Det amerikanska programmet Inroads med applikationen Storm & Sanitary är kopplat till två
CAD­program (AutoCAD och Microstation). Det kan återge ledningsnätet i tre dimensioner
och kan dimensionera dagvattennät, dock har detta program inte undersökts för nordiska
förhållanden och svenska riktlinjer.

En teoretisk jämförelse har gjorts mellan beräkningsmetoder enligt svenska riktlinjer och
programmet Storm & Sanitary. De beräkningsmetoder i Storm & Sanitary som bäst
överensstämt med de svenska riktlinjerna har sedan använts på två begränsade
avrinningsområden och jämförts med de beräknade resultaten från de svenska riktlinjerna.

Slutsatser som kan dras av arbetet är att beräkningarna i Storm & Sanitary och beräkningar
enligt svenska riktlinjer ger likartat resultat vid flödesberäkningar. Vad gäller
kapacitetsberäkningarna då rören har en bestämd dimension stämmer även de överens mellan
Storm & Sanitary och de svenska riktlinjerna. Användandet av Storm & Sanitary blir mer tid­
och kostnadseffektivt i stora komplicerade projekt, där premisserna ofta ändras under
projektets gång.

Nyckelord: dagvattenledning, dimensionering, Storm & Sanitary
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ABSTRACT
Dimensioning of storm water systems with Inroads Storm & Sanitary®

Camilla Hansen

When dimensioning a storm water system in Sweden many of the calculations are made by
hand. This is a very time consuming process and the smallest number of changes in the
structure of the system demands that recalculation has to be done for each alteration. The
commercially available programs for calculating hydrodynamic models which are being used
in Scandinavia calculate flows in a too complex manner when dimensioning for a smaller
system. They are also incompatible with any of the most used design programs and lack the
ability to present the system in 3 dimensions.

The American program Inroads® with the Storm & Sanitary toolbox is compatible with the
majority of the available design programs. The software can represent the system in three
dimensions and has the ability to dimension storm water pipes. However the Storm &
Sanitary program has never been evaluated for Scandinavian conditions or even compared to
Swedish guideline calculations.

A theoretical comparison has been made between calculations methods within the Storm &
Sanitary software and the calculation guidelines used in Sweden. The methods used in Storm
& Sanitary that best match the calculations according to Swedish guidelines have been further
used to compare the calculations for two restricted geographical catchment areas.

The conclusion of the work is that the calculations made in the Storm & Sanitary and those
calculated according to Swedish guidelines give comparable results when calculating the
flow. When determining the capacity for pipe of fixed dimensions the calculations again give
a similar result. As a conclusion can also be said that during large projects where basic
conditions change the Inroads® program becomes highly cost effective.

Keyword: storm water system, dimensioning, Storm & Sanitary
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Dimensionering av dagvattenledningar med programmet
Inroads Storm & Sanitary

Populärvetenskaplig sammanfattning

Avloppssystem byggs idag som separerade system där spillvatten från bland annat hushåll och
industrier tas om hand för sig, medan regnvatten från gator och tak, så kallat dagvatten, tas om
hand för sig. Spillvattenledningar är tämligen enkla att dimensionera då det finns siffror på
den specifika vattenförbrukningen för hushåll som är relaterad till mängden genererat
spillvatten. Dimensionering av dagvattenledningar beror däremot på markens
användningsområden och sammansättning samt nederbördens intensitet och varaktighet över
området. För att underlätta dimensioneringsarbetet har Svenskt Vatten AB tillsammans med
experter tagit fram riktlinjer för hur beräkningarna ska utföras. Dessa riktlinjer ligger inte bara
till grund för själva beräkningarna utan även vid juridiska värderingar om
skadeståndsskyldigheter då översvämningar har inträffat. Även då riktlinjerna finns är
dimensionering av dagvattenledningar ett tidskrävande och enformigt arbete. Dels ska flöden
beräknas för alla delavrinningsområden och rör dels ska ledningarna sedan läggas in i ett
projekteringsprogram för att generera bygghandlingar. Då ny information tillkommer eller
något ändras i projektet finns en risk att stora delar av beräkningarna måste göras om, vilket
kan inträffa ett flertal gånger vid omfattande projekt. Att förenkla och effektivisera arbetet är
därför önskvärt.

Det amerikanska programmet Inroads Storm & Sanitary kan dimensionera och projektera
dagvattenledningar med CAD­programmet Microstation som plattform. För att Storm &
Sanitary ska kunna användas i Sverige både vid dimensionering av ledningarna och vid
projektering fordras att programmet kan efterlikna resultat från de svenska riktlinjerna.

Då beräkningsmetoderna i de svenska riktlinjerna och Storm & Sanitary jämfördes upptäcktes
det att vissa metoder i Storm & Sanitary överensstämde med de svenska riktlinjerna. Metoden
som beskrivs för beräkning av det dimensionerande flödet i de svenska riktlinjerna är ett
samband mellan flöde, regnintensitet beroende av koncentrationstid, area och
avrinningskoefficient, vilket kallas för den rationella metoden. I de svenska riktlinjerna
beskrivs även normer angående regnets återkomsttid och varaktighet och därtill även hur
avrinningskoefficienterna bestäms. Dessa normer gick att återskapa i Storm & Sanitary. För
beräkning av rörens dimension används Prandtl­Colebrooks ekvation i de svenska riktlinjerna.
Denna ekvation gick även att välja i Storm & Sanitary.

För att möjliggöra en explicit jämförelse av resultaten från de svenska riktlinjerna och de
beräkningssätt som mest påminde om de svenska riktlinjerna i Storm & Sanitary användes två
områden med enkla ledningsnät. Det ena området användes vid en jämförelse mellan hur
olika koncentrationstider påverkade flödet. Därtill användes det även för att bedöma hur pass
väl Storm & Sanitary förmådde beräkna rördimensioner jämfört med de svenska riktlinjerna.
Det andra området användes för att avgöra hur pass väl Storm & Sanitary kunde beräkna
dagvattenflödet då avrinningsområdena bestod av flera olika markanvändningstyper.



v

Resultaten visar att Storm & Sanitary kan användas vid beräkning av det dimensionerande
flödet. Programmet går även att använda vid dimensionering av ledningarna om rörens
dimension kontrolleras efteråt så att rören i huvudledningen enbart skiftar till större storlekar
nedströms. Svårigheten med att få Storm & Sanitary att beräkna rörens dimension till samma
storlek som de storlekar som bedöms rimliga enligt de svenska riktlinjerna är att programmet
inte går att ställa in så att det byter rörstorlek vid en viss fyllnadsgrad. Trots svårigheten med
att dimensionera rörledningarna i överensstämmelse med de svenska riktlinjerna effektiviserar
Storm & Sanitary projekteringsarbetet, särskilt vid projekt där många olika bitar projekteras
samtidigt.
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1 INLEDNING
Avloppssystem byggs idag som separerade system där spillvatten från hushåll och industrier
m.m. avleds för sig medan regnvatten från gator och tak, så kallat dagvatten, tas om hand för
sig. Hur mycket spillvatten en ledning behöver dimensioneras för är relativt lätt att få fram, då
det finns siffror på hur mycket vatten ett genomsnittligt hushåll använder per person och dag
(Svenskt Vatten, 2004). Det finns även schablonvärden på användandet av vatten i industrier,
affärer och sjukhus (Svenskt Vatten, 2004). Mängden dagvatten en ledning bör dimensioneras
för beror däremot på markens geologiska sammansättning och hur den används, samt hur
mycket det regnar. Utifrån planritning, platsbesök och därtill även utvärdering av flygfoton
och satellitbilder kan man avgöra hur mycket avrunnet vatten olika delar av området kommer
att bidra med. Olika sorters mark kan infiltrera olika mycket vatten. Hur mycket ett specifikt
område bidrar till avrinningen beror på hur stor andel av nederbörden som inte infiltreras,
avrinningskoefficienten för området, och på områdets area. Regn påverkar mängden
dagvatten genom både intensitet och varaktighet. Dessa faktorer fås fram genom
regnmätningar som påvisar att nederbörd varierar mycket över tid och plats (Dahlström 2006).
För att se till att vatten­ och avloppshanteringen sker på liknande sätt i hela landet och för att
hjälpa medlemmarna tekniskt, ekonomiskt och juridiskt med dessa frågor bildade Sveriges
kommuner Svenskt Vatten AB (Svensk Vatten, 2007). Svenskt Vatten AB har sedan
tillsammans med experter från området tagit fram anvisningar för hur allmänna
avloppsledningar ska dimensioneras (Svenskt Vatten, 2004). Dessa riktlinjer ligger sedan till
grund även för den juridiska värderingen av skadeståndsskyldigheter då översvämningar sker
(Svenskt Vatten, 2004).

Vid dimensionering av dagvattennät, används idag samband som till stor del introducerades i
slutet av 1800­talet (Chow 1964) som den ”rationella metoden”. Beräkningarna utförs ofta
med hjälp av exceltabeller eller diagram. Detta är ett tidskrävande arbetssätt som inte följt
med i utvecklingen av det datoriserade samhället. Då ny information tillkommer till projektet
eller parametrarna för något avrinningsområde ändras, vilket kan hända ett flertal gånger
under ett projekt, behöver dessa steg göras om manuellt för varje del av ledningsnätet.
Sammanlagt kan det leda till att en mängd av beräkningsstegen måste göras om, vilket leder
till att risken för felberäkningar ökar. De beräknade rördimensionerna överförs sedan till olika
CAD­program som används för att få fram ritningar över ledningsnätet. Ofta kombineras detta
med geografisk information över området, samt de övriga byggåtgärder som planeras i
området. I dagens samhälle där GIS och CAD används vid projektering bör även arbetet med
dimensioneringen av ledningsnätet kunna bli mer effektivt.

Det finns hydrodynamiska ledningsnätsmodelleringsprogram som kan användas för att
dimensionera ledningsnät, (Chow 1988, Jones 1997) exempel på dessa är Mike Urban och
SWMM (DHI­group, 2007). Dessa har för nuvarande ingen direkt koppling till de CAD­
baserade ritprogram som används som projekteringsprogram. I dagsläget används de
hydrodynamiska ledningsnätsmodellerna mestadels för beräkningar och simuleringar av
befintliga ledningsnät. Särskilt används de vid översvämningsproblematik, eller för
dimensionering och kontrollberäkningar av komplexa nät (Chow 1988). Fördelen med dem är
att de tar hänsyn till dämningseffekter i rören, samt variationer i flödet med tiden. De kan
även beräkna transporter av föroreningar samt simulera fram långa tidsserier för statistiska
ändamål (Chow 1988). Än så länge har dessa program inte börjat anpassats till användning i
tre dimensioner. Vid projektering av enklare ledningsnät där dimensionering och placering av
rören är det essentiella räcker det dock ofta med beräkningar utförda enligt stationära
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beräkningsmetoder. Dessa metoder ger en viss säkerhet eftersom de tenderar att
överdimensionera rören nedströms i ledningsnätet (Lund­Weiss muntligen, 2007).

Ett program som är kopplat till både GIS och CAD är det amerikanska programmet Inroads
(Bentley, 2007). Inroads har en applikation, Storm & Sanitary, som kan sköta både
projektering och dimensionering av rörledningssystem med enkla beräkningar. Programmet
ingår i en stor familj av olika projekteringsprogram som kan samordnas i omfattande projekt
och som kan förevisas i tre dimensioner (Bentley, 2007).

Det här projektet gick ut på att jämföra beräkningssätten och resultat mellan Storm & Sanitary
och det nuvarande sättet att utföra projektering och dimensionering för dagvattenledningsnät.
Syftet var dels att undersöka om programmet kunde utföra dimensioneringen på ett sätt som
är effektivare och enklare än det nuvarande beräkningssättet dels att ta fram en
rekommendation för hur dimensioneringsdelen skulle kunna användas vid projektering. Detta
gjordes genom att gå igenom teorin bakom de båda sätten samt genom att utföra beräkningar
och jämföra resultaten på två olika områden. I slutfasen har även en enkel svensk
användarmanual för dimensionering i Storm & Sanitary tagits fram.

2 TEORI
I detta avsnitt behandlas teorin bakom de beräkningsmetoder som används i de svenska
riktlinjerna och Storm & Sanitary.

2.1 SVENSKA RIKTLINJER
För dimensionering av dagvattenledningsnät använder man sig av riktlinjerna som är
framtagna av Svenskt Vatten och av de rekommenderade beräkningssätten (Lund­Weiss
muntligen, 2007). Riktlinjerna anger bland annat vilka nederbördsåterkomsttider ett
ledningsnät ska dimensioneras efter. Nederbördens återkomsttid väljs efter ett enkelt schema
som överslagsmässigt tar hänsyn till skadepotentialen om det avvattnade området skulle
översvämmas. Vid en juridisk bedömning av skadeståndsskyldigheter vid översvämningar tar
man hänsyn till om ledningsnätet är dimensionerat efter riktlinjerna eller ej. Dessa
beräkningssätt och riktlinjer finns i en publikation från Svenskt Vatten (2004), som kallas
P90. Publikationen bygger på en tidigare publikation från 1975 (Svenskt Vatten, 2004). De
förändringar som gjorts mellan dessa publikationer har mestadels med anpassning till
datormodeller att göra (Svenskt Vatten, 2004). Riktlinjerna i P90 föreskriver vilken
återkomsttid för regn som bör användas för olika sorters områden beroende på ledningsnätet
som ska dimensioneras. Ledningsnäten kan antingen vara ett kombinerat system där dagvatten
och spillvatten leds bort tillsammans eller duplikata system där de leds bort var för sig
(Selander, 1976). Områden med citybebyggelse där dagvatten kan avledas via ytan endast
med hjälp av självfall kallas enligt definition ej instängda områden. För dessa områden är
återkomsttiden för det dimensionerande regnet två år vid användandet av enbart
dagvattenledning. För så kallade instängda områden med citybebyggelse där dagvatten inte
kan rinna av efter ytans lutning är den 10 år för enbart dagvattenledning.

2.1.1 Dimensionering av ledningsnät
Dimensionering av ett ledningsnät sker i två steg. Först beräknas de dimensionerande flödena
för avrinningsytorna och sedan beräknas ledningarnas kapacitet med avseende på flödena för
att se om rören klarar att avleda dessa.
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Metoden som används för dimensioneringen av ledningsnät i Sverige kallas för rationella
metoden. Denna metod tar inte hänsyn till att våta och torra avrinningsområden i verkligheten
reagerar olika på liknande nederbörd. Däremot passar den utmärkt för att bestämma flöden
från relativt små avrinningsområden bestående till stor del av hårdgjorda ytor (Jones, 1997).

För att verifiera resultat och göra en rimlighetsbedömning görs en grov uppskattning av hela
områdets area och sammansättning av markanvändningstyper. Därefter sätts dessa värden in i
beräkningen och jämförs med värdet för det rör som är mest nedströms i området (Lund­
Weiss muntligen, 2007).

Rationella metoden
Den rationella metoden är den äldsta och enklaste modellen för att förutspå den maximala
avrinningen från ett område (dimensionerande flödet) (Jones, 1997). För att metoden ska
kunna användas måste tre villkor vara uppfyllda:

• Området bör vara i det närmaste rektangulärt.

• Avrinningskoefficienter med liknande värde bör vara jämnt fördelade över området.

• Rinntiderna inom olika delområden får inte fluktuera alltför mycket.

Om villkoren ej kan uppfyllas måste beräkning av avrinningen ske med noggrannare
beräkningsmetoder (Svenskt Vatten, 2004).

I den rationella metoden beräknas det dimensionerande flödet enligt

( )rtiAq ⋅⋅= ϕdim (1)

där dimq är det dimensionerande flödet [l/s], A är avrinningsområdets area [ha], ϕ  är
avrinningskoefficienten [­], ( )rti  är den dimensionerade nederbördsintensiteten [l/s·ha] och tr

[min] är regnets varaktighet som i den rationella metoden är lika med områdets
koncentrationstid tc. (Jones, 1997.) Koncentrationstid är den tid det tar för vattnet att ta sig
från den hydrologiskt mest avlägsna punkten till mätpunkten (Jones, 1997).

Avrinningskoefficienten beskriver hur stor andel av nederbörden som genererar avrinning.
Den beror på andelen hårdgjord yta, områdets lutning och beskaffenhet samt regnets
intensitet. För att beräkna den sammanvägda avrinningskoefficienten används följande
ekvation

).../()...( 212211 nnn AAAAAA ++++++= ϕϕϕϕ (2)
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Värden på avrinningskoefficienten tas från denna tabell.

Tabell 1. Avrinningskoefficienter för olika typer av underlag. (Svenskt Vatten, 2004 s. 21)
Typ av yta Avrinningskoeff.

Tak 0,9
Betong­ och asfaltsyta, berg i dagen stark lutning 0,8

Stensatt yta med grusfogar 0,7
Grusväg, starkt lutande bergigt parkområde utan nämnvärd vegetation 0,4

Berg i dagen i inte alltför stark lutning 0,3
Grusplan och grusad gång, obebyggd kvartersmark 0,2

Park m rik vegetation samt kuperad bergig skogsmark 0,1
Odlad mark, gräsyta, ängsmark mm           0­0,1

Flack tätbevuxen skogsmark           0­0,1

Vid dimensionering av avrinning måste även koncentrationstiden på mark och i ledningar
uppströms beräkningspunkten tas med. Detta kan göras utifrån områdets egenskaper. Ett
sådant empiriskt samband är

)/()(043,0 05,035,032,071,0
80 delhhc ASiLt ⋅⋅= (3)

där 80hL  [m] är huvudledningens längd fram till den längst uppströms liggande brunnen plus
80 m, i  är regnintensiteten [l/s·ha], Sh är huvudledningens medellutning [­] och Adel är den
reducerade arean [ha]. Oftast använder man rationella metoden till överslagsberäkningar och
då bryr man sig inte om rörens koncentrationstid.

Rörkapacitet
I de svenska riktlinjerna används Prandtl­Colebrooks ekvation för beräkning av rörens
dimensioner.


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2
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0
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2π
(4)

där D är rörets diameter [m], 0S är ledningens lutning, v  är den kinematiska viskositeten
[m2/s] (1,3 10­6 vid °10 C) och k är skrovligheten [mm] (1,0 för betong).

För att erhålla rörets diameter provar man sig fram bland standarddimensionerna. En viss
överkapacitet hos röret är önskvärd för att dels ge en ökad säkerhetsmarginal dels ge en
möjlighet till att ansluta nya rör i framtiden. Fyllnadsgrad används för att mäta
överkapaciteten.

Fyllnadsgrad = Flöde/Kapacitet (5)

Där kapaciteten [m3/s] är det maximala flödet i ett rör då det är helt fyllt.
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Regnenveloppmetoden
Då dagvattnet tas upp i magasin eller tas om hand inom det område där det bildas (så kallat
lokalt omhändertagande av dagvatten) kan den rationella metoden inte användas för att ange
det dimensionerande flödet nedströms anläggningen. I stället används regnenveloppmetoden
som är en överslagsberäkningsmetod för bestämning av dimensionerande flöden nedströms
magasin eller liknande anläggningar. Då regnenveloppmetoden inte tar hänsyn till rinntiden
passar den bäst för magasin med liten avtappning, < 20­30 l/s·ha. Då blir långvariga regn
dimensionerande för magasinets storlek. Magasinsvolymen bestäms enligt

)]()([maxdim tVtVM utin −= (6)

28,0
010 tiVin ⋅⋅= (7)

tqV utut ⋅⋅= 4,86 (8)

där inV  är tillrinningsenvelopp [m3/ha], utV är ackumulerat flöde [m3/ha], t är varaktigheten
hos regnets maximala medelintensitet [dygn], i0 är regnintensiteten för t=1 och aktuell
återkomsttid [mm/dygn] och utq är det strypta flödet från anläggningen [l/s·ha].

När Mdim beräknats för anläggningen och rör utifrån densamma kan man återgå till rationella
metoden för resten av om rådet. (Svenskt Vatten, 2004)

2.1.2 Nederbörd
I P90 används Z­värden för att bestämma sambandet mellan regnets intensitet och varaktighet.
Dessa Z­värden presenterades av Dahlström i slutet av 1970­talet enligt

vNNNZ −+= )(5,0' 87 (9)

där N7, N8 och Nv är medelnederbörden 1931­1960 under juli, augusti och en vårmånad,
vanligen maj. Z­värdena fås från en karta över Sverige.

Sambandet mellan regnintensitet och regnets varaktighet blir

cbZaZti r )(78,2),( ⋅+= (10)

där a och b är konstanter med olika värden beroende på återkomsttiden T för vissa
regnintensiteter.
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Tabell 2. Värden för parameter a och b för olika återkomsttider. (P90 s.19)
Återkomsttid, T Konstanter

[månader] a b

12  5,38 0,272

24  7,53 0,293
60 11,63 0,309

120 16,12 0,314

c är en parameter som beror av regnets varaktighet.

Tabell 3. Värden för parametern c för olika regnvaraktigheter. (P90 s.19)
tr [min] 10  15 20 25 30 35 40 45 50 55 60

c 3,62 2,96  2,41  2,06  1,81  1,62  1,47  1,35  1,25  1,17  1,10
tr [h] 1 1,5 2 3 4 6 8 12 16 20 24

c 1,10 0,821 0,667 0,499 0,405 0,303 0,246 0,184 0,149 0,127 0,112

För beräkningar som inte är typfall är

147,07,1 −−= TTa (11)

1)3(72,032,0 −+−= Tb (12)

( ) ( )[ ] 72,0157,0/167,01,01 −−−+= rrr tttc (13)

För att kunna behandla nya regndata infördes en regndefinition av Hernebring (2006). På så
sätt kunde han dela upp de kontinuerliga dataserierna i regntillfällen samt utesluta små regn
som har liten eller saknar inverkan på dagvattenhanteringen.

Regndefinitionen består av en parameter som begränsar hur lång en period med noll
nederbörd kan vara innan regnet delas upp i två regn samt minsta regnintensitet och minsta
regnvolym. Längsta uppehållstid inom ett och samma regn bestämdes till två timmar. Minsta
regnintensitet avgränsades till 0,1 mm/h och minsta regnvolym till 2 mm. Regn mindre än
dessa två utesluts ur beräkningarna. (Hernebring, 2006)

Regn­klimatförändringar
Det finns inget underlag för att beräkna hur klimatförändringar kommer att påverka
dimensionering av dagvattenledningar (Svenskt Vatten, 2004). Främst beror det på
svårigheter att modellera framtida väderscenarion. Hernebring (2006) och Dahlström (2006)
beskriver båda statistik från 1971­2000 där en minskning av nederbörd i södra Sverige och en
ökning i norra har skett jämfört med perioden 1961­1990. Dessa skillnader ligger mellan ±5­
10 % jämfört med tidigare studier vilket kan sägas ligga inom felmarginalen för mätningarna
Hernebring (2006). Dahlström (2006) påpekar att minskningen i regnintensitet även innebär
en minskning i Z­värdena, främst i sydvästra Götaland men även i Dalarna. Dahlström (2006)
och Hernebring (2006) framhåller även att det är viktigt för branschen att uppdatera sig
regelbundet om nya forskningsrön i frågan för att göra så korrekta bedömningar som möjligt
av situationen.
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2.2 STORM & SANITARY
Storm & Sanitary ingår i det amerikanska företaget Bentleys utbud av program för
projektering inom arkitektur­, infrastruktur­ och byggsektorn. Alla deras program går att
använda i AutoCAD eller Bentleys egna CAD program MicroStation. (Bentley, 2007)

Med Storm & Sanitary kan man bland annat bygga tredimensionella modeller, designa nya
ledningsnät och simulera flöden. Fördelen med att se nätet i tre dimensioner är att det blir
lättare att se helheten och upptäcka brister. Det underlättar även för projekt i stadsmiljö där
marken redan innehåller en mängd andra ledningar samt konstruktioner eftersom det tydligt
syns var dessa kan kollidera med varandra. I Storm & Sanitary går det även att analysera hur
ett befintligt ledningsnät klarar olika scenarier och förändringar. Programmet innehåller
verktyg för att beräkna och analysera hydrologiska och hydrauliska problem (Bentley, 2007).
I programmet behöver en rad inställningar göras innan beräkningar kan utföras. Dessa
inställningar berör en mängd faktorer, från vilka övergripande ekvationer som ska användas
till hur stor andel av en viss brunn som effektivt tar emot det avrinnande vattnet.

Vid simulering av dagvatten i ett område behöver programmet en mängd bakgrundsfakta
såsom bland annat filer över nederbördsdata, områdets planlösning och befintliga ledningar.
Till programmet hör även ett bibliotek över exempelvis rördimensioner, olika sorters brunnar,
material som kan utökas efter behov.

2.2.1 Dimensionering av ledningsnät
I Storm & Sanitary finns det två olika sätt att beräkna det dimensionerande flödet, dels den
rationella metoden och dels med hjälp av SCS (Soil Conservation Service) enhetshydrografer
(Bentley, 2004). I detta projekt kommer endast den rationella metoden användas. Det finns
även två ekvationer att välja mellan för beräkning av ledningens kapacitet beroende av det
dimensionerande flödet. I det här arbetet beskrivs endast Prandt­Colebrook.

Rationella metoden
Även Storm & Sanitary använder ekvation 1. Skillnaden mellan P90 och Storm & Sanitary är
att i programmet finns det möjlighet att beräkna koncentrationstiden på tre olika sätt. I det här
arbetet tas enbart två av metoderna upp, FAA och Kirpich. Den tredje metoden använder sig
av en variant av den kinematiska vågekvationen och delar upp vattnets längsta sträcka i olika
delar beroende på hur avrinningen sker. Enligt FAA (U.S. Federal Aviation Administration)
beräknas koncentrationstiden [min]

3121
1 )1,1( −⋅−= sLKtc ϕ (14)

Där 1K  är en enhetsberoende konstant med värdet 3,26 för SI­enheter, ϕ  är
avrinningskoefficienten [­], L är vattnets maximala transportsträcka [m] och s är områdets
lutning [%]. Sambandet togs från början fram för att beräkna avrinningen från flygplatser,
men kan även tillämpas på andra urbana områden (Chow, 1988). Enligt (LMNOeng, 2007) är
FAA­metoden den mest använda metoden av de två och även den metod som rekommenderas
av American Society of Civil Engineers.
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Kirpichs metod är ett empiriskt samband som används vid större områden.

385,077,0
2

−⋅⋅= sLKtc (15)

Där 2K  är en enhetsberoende konstant med värdet 0,0195 för SI­enheter, L och s står för
samma sak som i föregående formel (Chow, 1964). Sambandet togs fram genom att man
mätte hur lång tid det tog för vattnet att stiga från den lägsta till högsta nivån i en
väldefinierad kanal med branta kanter efter ett regn (Chow, 1964 & LMNOeng, 2007).
Uttrycket är egentligen framtaget för flöden i naturliga kanaler men kan anpassas till
asfalterade ytor genom att dividera 2K  med 0,4 (Chow, 1988). Kirpichs metod påminner
mycket om det empiriska sambandet som används i P90.

För att beräkna avrinningskoefficienten för ett område som består av flera olika sorters mark
används ekvation 2.

Rörkapacitet
Kapaciteten hos ledningen kan bestämmas antingen genom att använda Mannings ekvation
eller Prandtl­Colebrook (Bentley, 2004). Då Prandtl­Colebrook används i de svenska
riktlinjerna valdes den metoden även vid tillämpningen i Storm & Sanitary.

Programmet provar sig fram bland de olika rördimensionerna som finns angivna i
programmets inställningar för att hitta det minsta röret som klarar av det angivna flödet.

2.2.2 Nederbörd
I Storm & Sanitary kan antingen regnets intensitet specificeras direkt eller så kan
koncentrationstiden användas för att få fram erforderlig regnintensitet. Då koncentrationstiden
används finns tre olika metoder att välja mellan. Den första utnyttjar sambandet mellan
intensitet, varaktighet och frekvens (engelsk förkortning IDF) hos regnen. Den andra
använder regn och koncentrationstid och den tredje metoden är att använda ekvationen

c
c bt

ai
)( +

= (16)

Där i är det dimensionerande regnets intensitet [mm/h], ct  är koncentrationstiden, a, b och c
är konstanter från regnintensitet­ och varaktighetskurvor.

Regnintensitet­ och varaktighetskurvor
IDF motsvarar de svenska regnintensitets­ och varaktighetskurvor som finns för specifika
platser i Sverige. Dessa tas fram genom att först behandla insamlade regndata med statistiska
metoder för att kunna skatta nederbördsintensiteter för olika varaktigheter och återkomsttider.
För att kunna bestämma värden på konstanterna a, b och c används olika metoder. Hernebring
(2006) anpassade data numeriskt genom att logaritmera uttrycket och låta b variera så att
kurvorna blev så raka som möjligt sedan användes regression för att bestämma a och c.

I projektet användes värden på intensitet och varaktighet från SMHI. Dessa värden är
beräknade för områden i Sverige med ett Z­värde på 18.
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Figur 1. Intensitet och varaktighetskurva för Z­värde 18. Kurvorna visar återkomsttiderna 1, 2, 5, 10 och
50 år där kurvan motsvarande en återkomsttid på 1 år är den nedersta.

Storm & Sanitary använder IDF kurvornas värden i tabellform. Programmet interpolerar
mellan värdena då en koncentrationstid anges som ej existerar i tabellen.

Tabell 4. Intensitet för olika långa regn beroende på återkomsttid och koncentrationstid [min] för Z­värde
18. Värden för 1­5 minuter är extrapolerade.

Minuter Återkomsttider [år]
1 2 5 10

[mm/hr] [mm/hr] [mm/hr] [mm/hr]
1 177,5 221,5 296,4 375,6
3   80,6 100,6 134,6 170,6
5   55,8   69,5   93,6 118,4
10   37,1   46,4   62,3   93,6
15   30,2   37,8   50,8   62,3
20   24,5   30,6   41,4   52,6
25   20,9   26,3   35,3   44,6
30   18,4   23,0   29,9   39,2

3 MATERIAL & METODER
För att resultaten av de båda beräkningssätten skulle efterlikna varandra valdes de
beräkningssätt i Storm & Sanitary som mest påminde om beräkningssätten i de svenska
riktlinjerna. Den rationella metoden visade sig även vara betydligt lättare rent
inställningsmässigt att utföra i programmet, än metoden som bygger på enhetshydrografer.

I den rationella metoden är val av lämplig koncentrationstid betydelsefull. Testområdena
består av små delavrinningsområden, därför valdes koncentrationstiden för beräkning enligt
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de svenska riktlinjerna till tio minuter vilket är det minsta värdet på koncentrationstid i de
svenska riktlinjerna. I Storm & Sanitary gjordes flödesberäkningar dels med två olika metoder
för platsspecifik bestämning av koncentrationstiden dels med värdet tio minuter efter de
svenska riktlinjerna. Programmet beräknade även hur flödena påverkades av rörens
koncentrationstid. De svenska riktlinjerna bortser från att rörens längd påverkar flödenas
storlek.

Då delavrinningsområdena består av olika sorters markanvändningstyper krävs en sammansatt
avrinningskoefficient för att flödet ska kunna beräknas. Koefficienten beräknas på liknande
sätt i Storm & Sanitary som i de svenska riktlinjerna.

I Storm & Sanitary kan man välja om programmet ska beräkna rörens dimensioner eller om
de ska anges manuellt då nätet läggs ut. För det första området användes både de befintliga
rörstorlekarna och dimensionering av rören med Storm & Sanitary. Dimensioneringen av
ledningsnätet i det första området gjordes enbart för den undre ledningen då den övre
ledningen är dimensionerad för en längre återkomsttid på vissa sträckor. För det andra
området fanns ingen kunskap om rörens dimensioner och därför beräknades rören enbart av
programmet. All information som Storm & Sanitary behöver för att beräkna dimensionerna
hämtas automatiskt från existerande fakta i ledningsnätet.

Vid dimensionering av dagvattenledningar bör erfarenhetsmässigt rör med en storlek   400
mm ha en fyllnadsgrad under 90 % ur säkerhetssynpunkt för att vara tillräckligt
överdimensionerat, rör över 400 mm bör högst ha 95 % fyllnadsgrad (Lund­Weiss, muntligen,
2007).

Områdena där beräkningarna genomfördes valdes därför att de var små och hade
okomplicerade ledningsnät som fanns i Storm & Sanitary. Områdena valdes också för att testa
olika delar av beräkningarna. Det första området bestod av ytor där lutningen enkelt kunde
bestämmas och användes därför till att jämföra hur beräkningarna av koncentrationstid
påverkade flödet. Det andra området bestod av villatomter och asfaltsväg och användes för att
undersöka hur användandet av sammansatta avrinningskoefficienter påverkade beräkningarna.

Först beräknades flödena enligt P90 och sedan jämfördes de med flöden som simulerats fram i
Storm & Sanitary. Utifrån de dimensionerande flödena beräknades sedan flödet längs hela
rörsystemet antingen manuellt, (figur 2), eller med Storm & Sanitary. I Storm & Sanitary
gjordes även simuleringar där rörens koncentrationstid togs med.

Figur 2. Förklaring hur flödena beräknas manuellt för varje separat rör. P1 har ett flöde på 27 l/s. P2 tar
emot 5 l/s via dagvattenbrunnen (fyrkant) som avvattnar ett avrinnigsområde. Rören P1 och P2 kopplas
ihop med en nedstigningsbrunn (cirkel), flödena från dessa båda rör bildar flödet i P3 på 32 l/s.
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3.1 OMRÅDEN

3.1.1 Område 1
De första simuleringarna gjordes för det framtida vägområdet som är en del av Norra länken
på området vid Roslagsvägen nära Stockholms universitet, Stockholm. Området bestod
mestadels av vägbana. Detta gjorde beräkningarna lättare då det framtida vägområdet kunde
delas in i delavrinningsområden där lutningen enkelt bestämdes utifrån vägens lutning.

Rörledningsnätet där flödena simulerades fanns till stor del redan upplagt i Storm & Sanitary.
Ett antal brunnar och rör lades till för att varje avrinningsområde skulle ha tillgång till minst
en brunn som var kopplad till rörledningsnätet.

Figur 3. Ledningsnät och delavrinningsområden i Storm & Sanitary. Fyrkanterna symboliserar
dagvattenbrunnar och är kraftigt förstorade.

Totalt bestod området av 27 avrinningsområden. Varje delområde var kopplat till en brunn
inom den specifika avrinningsytan. Rörledningsnätet bestod av över 80 rör av olika
dimensioner och med olika lutningar.

3.1.2 Område 2
Det andra området var en del av ett villaområde öster om Stockholm. Avrinningsområdena
bestod till stor del av gräs och hårdgjord yta.

Befintliga terrängdata samt den befintliga rörledningens sträckning lades in i Storm &
Sanitary. För att kunna simulera lades ett rörnät med brunnar och nedstigningsbrunnar ut
ungefär så som det befintliga nätet ligger. Avrinningsområdena ritades upp efter
terrängmodellen samt efter de delar av tomtyta som kan förmodas avvattnas över befintligt
ledningsnät.
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Figur 4. Avrinningsområden och rörnät i Storm & Sanitary för område 2. Cirklar betecknar
nedstigningsbrunnar och fyrkanter dagvattenbrunnar.

Marken lutade från vänster till höger i bilden. Över tomtytorna till vänster i bilden
avvattnades även skogsområdet som har en brant lutning in mot tomterna. Gatan sluttade
nedåt från övre delen av bilden till den nedre delen. Resultatet blev fem avrinningsområden
längs gatan kopplade till de utlagda gatubrunnarna. Totalt blev det 19 avrinningsområden. Av
dessa var tolv stycken villatomter med olika sorters markanvändning.
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Den hårdgjorda ytans avrinningskoefficient sattes till 0,9, skogssluttnigen antogs ha
avrinningskoefficienten 0,3 p g a den stora lutningen och gräsytan 0,1 från tabell 1. Dessa
värden användes sedan tillsammans med de uppmäta areorna, för de olika
markanvändningsområdena, för att beräkna den sammansatta avrinningskoefficienten.

Tabell 5. Sammansatta avrinningskoefficienter för delavrinningsområdena i villaområdet beräknade
enligt svenska riktlinjer och med Storm & Sanitary, anges som procent av värdet enligt de svenska
riktlinjerna.

Sammansatt
Delområde avrinningskoefficient

svenska riktlinjer
Storm & Sanitary

 [% av de svenska riktlinjerna]
1 0,17   99
2 0,24 100
3 0,27 100
4 0,28 101
5 0,27   98
6 0,20   99
7 0,30 101
8 0,37 100
9 0,80 100
10 0,80 100
11 0,80 100
12 0,80 100
13 0,80 100
14 0,27   99
15 0,36   99
16 0,31 101
17 0,39 100
18 0,27   99
19 0,30 100

3.2 TILLVÄGAGÅNGSSÄTT

3.2.1 VAV P90 – traditionellt beräkningssätt
Enligt svenska riktlinjer används ekvation 1 för uppskattning av de dimensionerande flödena.
De olika områdenas areor fås av projekteringsprogrammet. Avrinningskoefficienten för olika
ytor erhålls ur tabell 1. Alla delavrinningsytor i område 1 bestod av asfalt, utom ett som var en
brant grässlänt. Delavrinningsytorna i område 2 bestod av gräs, kuperad skog och hårdgjord
yta. För att beräkna den sammansatta avrinningskoefficienten användes ekvation 2.

Vid beräkning av den dimensionerande nederbördsintensiteten enligt ekvation 10 krävdes
kunskap om områdenas koncentrationstid och Z­värdet för norra Stockholm. Återkomsttiden
för regn som orsakar fylld ledning bestämdes utifrån områdenas karaktär. Då
avrinningsområdena ej var instängda områden, sattes dimensionerande återkomsttid för regn
till två år. Vid beräkning enligt det traditionella sättet sattes koncentrationstiden till 10
minuter som är det minsta värdet på koncentrationstiden i de svenska riktlinjerna och även
vanligt vid överslagsberäkning för små områden (Lund­Weiss, muntligen, 2007).
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När arean, avrinningskoefficienten och koncentrationstiden var bestämda för varje
avrinningsområde beräknades det dimensionerande flödet för respektive område. De
dimensionerande flödena adderades sedan enligt ledningsnätets uppbyggnad.

Bestämning av rörets dimension utförs enligt ekvation 4. Genom att prova de olika
standarddimensionerna valdes den rörstorlek som gav en rimlig överskottskapacitet. De
parametrar som varierar är flödet genom röret, rörets lutning och rörets skrovlighet. Flödet
genom varje enskilt rör beräknas genom att följa ledningsnätets struktur från
delavrinningsområdena ner till slutpunkten.

Rent praktiskt kräver dessa beräkningar att man använder sig av minst två excelblad. Det
första tar hand om beräkningarna av det dimensionerande flödet (se bilaga 1), vilket blir mer
komplicerat då avrinningsytorna består av olika markanvändningstyper. Anslutet till tabellen
över de dimensionerande flödena bör man även ha en tabell över ledningsnätets uppbyggnad,
där flödena för varje separat rör beräknas. I det andra bladet provar man sig fram med olika
rördimensioner då man vet rörets lutning, skrovlighetsvärde och det dimensionerande flödet
(se bilaga 2). Det första excelbladet används för varje avrinningsyta. Det andra bladet används
för varje rör samtidigt som man använder sig av projekteringsprogrammet för att få fram
rörets lutning och skrovlighetsvärde.

3.2.2 Storm & Sanitary
Vid beräknandet av det dimensionerande flöden med Storm & Sanitary användes också
ekvation 1. Areorna beräknades automatiskt av programmet då de ritats ut som polygoner i ett
lager på ritningen och kopplats till Storm & Sanitary. Avrinningskoefficienten togs från tabell
1 för det första området och beräknades enligt ekvation 2 för det andra området. För att få
fram de olika areorna för de skilda markanvändningstyperna ritades även dessa areor upp som
polygoner och storleken beräknades av programmet.

Koncentrationstiden beräknades enligt tre olika metoder för det första området. Den första
metoden var FAAs samband (ekvation 14). Denna metod kräver det längsta avstånd en droppe
vatten behöver färdas för att nå mätpunkten, lutningen för denna sträcka och
avrinningskoefficienten för området. Dessa parametrar erhölls från de uppritade
delavrinningsområdena i programmet. Kirpichs samband (ekvation 15) var den andra
metoden. Även där krävdes längsta väg och lutning. Den sista metoden var att sätta
koncentrationstiden till tio minuter. För det andra området användes enbart
koncentrationstiden tio minuter.

När koncentrationstiden var beräknad använde programmet den inlagda intensitets­ och
varaktighetstabellen för att beräkna regnets intensitet. Därefter beräknades flödet för alla areor
och rör automatiskt av programmet. I det första området innehåller vissa
delavrinningsområden två sammankopplade dagvattenbrunnar. Det dimensionerande flödet
från ytorna kan endast kopplas till en brunn men alla brunnar måste ha ett flöde för att
simuleringen ska kunna utföras. Därför injicerades ett litet flöde i den andra brunnen. Genom
att ändra på en inställning i programmet dimensionerades även rören.

4 RESULTAT

4.1 OMRÅDE 1
De dimensionerande flödena beräknade med FAAs metod och Kirpichs metod blev betydligt
högre än flödena beräknade enligt de svenska riktlinjerna. Anledningen till att båda dessa
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metoder beräknar högre flöden är att koncentrationstiderna blir betydligt kortare med dessa
metoder än med den svenska överslagsberäkningen. Koncentrationstiden avtar med ökad
regnintensitet och en högre regnintensitet ger ett högre flöde. Då koncentrationstiden angavs
till 10 minuter i Storm & Sanitary blev de dimensionerande flödena för varje område snarlika
de värden beräknade enligt de svenska riktlinjerna.

Tabell 6. Dimensionerande flöden för de olika avrinningsområdena och metoder för beräkning av
koncentrationstider i procent av flödena beräknade enligt de svenska riktlinjerna.

Del
område

Dimensionerande
flöde

Svenska riktlinjer
(10 min) [l/s]

FAA
[% av

svenska riktlinjer]

Kirpich
[% av

svenska riktlinjer]

Storm & Sanitary
(10 min) [% av

svenska riktlinjer]
1   9,5 177 155   99
2   8,8 205 197   98
3   4,3 202 188 100
4   8,7 174 155 100
5   3,6 233 217 100
6   5,9 171 144   98
7 15,3 149 128   99
8   9,5 204 179   99
9 14,0 241 202   99

10   9,3 286 257   99
11   8,9 326 316 100
12   5,0 382 398   98
13 16,1 224 199   99
14   4,1 278 239 100
15   8,7 233 201   99
16 12,5 258 210   99
17 12,4 202 176   99
18   9,2 193 168   99
19   9,3 186 158   99
20   8,8 164 142   99
21 11,7 184 161   99
22 15,1 142 119   99
23 9,9 206 183   99
24 10 245 208   99
25 21,3 188 151   99
26 1,2   25   75 100
27 9,2 247 208   99

Flödena för varje rör beroende på vald koncentrationstid visas i figur 5. Det syns tydligt i
figuren att flöden beräknade både med FAAs metod och Kirpichs metod är större än flödena
beräknade enligt svenska riktlinjer. Det blir också en tydlig skillnad mellan de simuleringar
där koncentrationstiden för rören finns med i beräkningen och där de inte gör det. Vid
simuleringar där koncentrationstiden för rören inte tas med blir flödena i ledningen nästan
dubbelt så stora som när de tas med för Kirpich och mer än dubbelt så stora då FAA används.
Flöden beräknade enligt svensk standard i Storm & Sanitary överensstämmer väl med flödena
som beräknats för hand.
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Figur 5. Flödena för varje huvudrörledning beräknade med olika koncentrationstider. Romber
symboliserar flöden beräknade efter de svenska riktlinjerna, trekanter är flöden beräknade med Storm &
Sanitary och fyrkanter betecknar flöden beräknade med Storm & Sanitary då beräkningen även
innefattar koncentrationstiden för rören.
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Kapaciteten beräknad för den undre rörledningen i Storm & Sanitary med samma rörstorlek
som i det befintliga ledningsnätet ger likvärdiga resultat med kapacitetsberäkningarna enligt
de svenska riktlinjerna.

Figur 6. Kapaciteten hos de befintliga rören i den nedre rörledningen beräknad enligt de svenska
riktlinjerna samt med Storm & Sanitary då koncentrationstiden var 10 minuter. Romber representerar
värden beräknade enligt svenska riktlinjer och trekanter betecknar värden enligt Storm & Sanitary.

Då rören dimensionerades i Storm & Sanitary märktes en skillnad av rörstorleken jämfört med
det befintliga nätet. Programmet räknar i några fall med en storlek mindre än de storlekar som
det befintliga nätet innehåller. Det märktes dock ingen skillnad i rörstorlek då rörens
koncentrationstid togs med i beräkningarna.

Figur 7. Rördimensioner för den undre ledningen. Romber representerar dimensioner på det befintliga
nätet, trekanter för mått beräknade med Storm & Sanitary och fyrkanter symboliserar rörstorlek där
koncentrationstiden i rören togs med i beräkningen.
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Vid beräkning av kapaciteten där rören dimensionerats med Storm & Sanitary blev det en
skillnad jämfört med värdena för det befintliga nätet. Detta beror dels på skillnaden i
rörstorlek men även att resultatet av flödesberäkningarna varierar något mellan metoderna.

Figur 8. Kapaciteten för den nedre ledningen då nätet är dimensionerat i Storm & Sanitary. Romber
symboliserar det befintliga nätets kapacitet och trekanter betecknar kapaciteten beräknade med Storm &
Sanitary. Beräkningar som inkluderar rörens koncentrationstid har inte tagits med då dessa stämmer
dåligt överens med flödesberäkningarna och därför har liten chans att stämma överens med
kapacitetsberäkningarna.

Då rörens fyllnadsgrad (Figur 9) jämförs förefaller det att det befintliga nätet har en låg
fyllnadsgrad i mittendelen av nätet som Storm & Sanitary inte kunde efterlikna då
dimensionen på rören beräknades till en storlek mindre i dessa fall.

Figur 9. Fyllnadsgrad för rören i den undre ledningen. Romber symboliserar det befintliga nätets
fyllnadsgrad och trekanter symboliserar fyllnadsgraden i rören dimensionerade av Storm & Sanitary.
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4.2 OMRÅDE 2
De dimensionerande flödena för varje delområde blev enligt tabell nedan.

Tabell 7. Dimensionerande flöden för de olika avrinningsområdena beräknade enligt de svenska
riktlinjerna och Storm & Sanitary, anges i procent av flödena enligt svenska riktlinjer.

Område
Dimensionerande

flöde
svenska riktlinjer Storm & Sanitary [%

av svenska riktlinjer]
1   9,0   98
2   5,5   98
3   5,0   98
4   8,0 100
5   7,0   97
6   7,0   99
7   2,6 100
8 13,4   99
9   5,1   98
10   0,5 100
11   3,1 100
12   1,5 100
13   2,9 100
14   2,8 100
15   2,5   96
16   2,6 100
17   2,4   96
18   2,8 100
19   1,8   94

I figuren ses att flödena beräknade i Storm & Sanitary stämmer väl överens med de flödena
som beräknats manuellt.

Figur 10. Flöden i huvudrörledningen beräknade enligt svenska riktlinjer både för hand och i Storm &
Sanitary. Romber anger flöden enligt de svenska riktlinjerna, trekanter flöden beräknade med Storm &
Sanitary och fyrkanter markerar flöden enligt Storm & Sanitary då rörens koncentrationstid beaktades.
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5 DISKUSSION
Då vissa av beräkningsmetoderna i Inroads applikation Storm & Sanitary jämförs med hur
dagvatten beräknas i de svenska riktlinjerna ses en tydlig likhet mellan resultaten då samma
koncentrationstid används. Utifrån de små och relativt enkla områden som använts för
jämförelse, anser jag att man kan använda Storm & Sanitary vid dagvattensimuleringar även
för andra större områden. Jag grundar det på att de parametrar som används är få, väl
definierade och hanteras på samma sätt oavsett om områdena är stora eller små. Både de
svenska riktlinjerna och Storm & Sanitary gör överslagsberäkningar av
dagvattendimensioneringen. Dessa bör därför täcka in risken för mindre fel. Regnets intensitet
är statistiskt bestämd för olika delar av Sverige. Att ändra på den är likvärdigt med att ändra
på regnets återkomsttid och därmed områdets typ, vilket är synonymt med att utföra
beräkningen för ett annat område. Även avrinningskoefficienterna är framtagna för att i
största möjliga mån motsvara olika markanvändningstyper och bör därför inte ändras. Att
markera fel area vid beräkningen kan inträffa men att göra så stora fel att det påverkar flödet
nämnvärt är svårt. Det gäller dock att vara observant vid utförandet och kontrollera areornas
inbördes storleksförhållande, samt regnets intensitet innan man utför simuleringen.

Storm & Sanitary underlättar dimensioneringsarbetet vid projektering av dagvattenledningar.
Arbetet löper smidigare då programmet används eftersom man inte behöver söka efter värden
i långa tabeller och diagram. Beräkning av rörens dimensioner för hela ledningsnätet utförs på
några sekunder, bedömt mot beräkningarna för hand som tar ungefär samma tid för enstaka
rör. En nackdel med programmet, jämfört med beräkningar enligt de svenska riktlinjerna, är
att Storm & Sanitary inte kan dela upp flödet från ett delområde till två dagvattenbrunnar.
Användandet av dubbla brunnar är vanligt i svackor på vägar där det är viktigt att allt vatten
kan omhändertas. En annan nackdel är att programmet beräknar rörens dimension endast
beroende av det dimensionerande flödet utan att ta inte hänsyn till storleken på röret
uppströms. Detta kan leda till att rörens dimension varierar så att ett rör på 400 mm,
nedströms kan övergå till ett rör på 300 mm. I Sverige är en sådan variation inte brukligt, utan
tanken är att rören ska bli större och större ju längre nedströms i ledningen de är.

De svenska riktlinjerna är utformade för att göra beräkningarna så lätta som möjligt att utföra.
Därför beräknas i stort sett aldrig koncentrationstiden vid överslagsberäkningar, utan den
antas vara tio minuter för relativt små områden. En anledning till val av koncentrationstid kan
vara att sambandet mellan regnets intensitet och varaktighet är bestämd som kortast till tio
minuter, det finns inget dokumenterat om osäkerheten vid kortare tillrinnigstider (Wern, via
mejl 2007). I Dahlström (2006) beskrivs ett nytt sätt att beräkna regnintensiteter. Ekvationen
gäller för hela Sverige och kan dessutom användas för koncentrationstider ned till 1,5 minuter
(Dahlström muntligen, 2007). Regnintensiteter beräknade med denna metod leder dock inte
till några större skillnader vid flödesberäkningar för de studerade områdena. Storm & Sanitary
är till skillnad från de svenska riktlinjerna, anpassat för att kunna göra så detaljerade
uträkningar som möjligt på en mängd olika sätt. Då projektet gick ut på att få liknande resultat
med programmet som med de svenska riktlinjerna fanns det alternativ som redan vid den
teoretiska jämförelsen kunde ignoreras.

De olika delarna av den rationella metoden, förutom koncentrationstiden för det första
området, beräknas på samma sätt i Storm & Sanitary som i de svenska riktlinjerna. Det som
gör att resultaten inte är exakt lika då samma koncentrationstid används beror på att
programmet anger intensiteten som heltal medan de manuella beräkningarna gjorts med det
exakta värdet från intensitet­ och varaktighetstabellen.
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Dimensioneringen med Storm & Sanitary av den nedre rörledningen i det första området
stämmer inte riktigt med det befintliga nätet. Fyllnadsgraden för det befintliga nätet är väldigt
låg vilket kan tyda på att det är mer än rimligt överdimensionerat.

Då programmet innehåller väldigt många inställningsmöjligheter tror jag att det enkelt kan
anpassas om nya riktlinjer inom ramen för den rationella metoden införs. Man kan själv bygga
upp ett bibliotek bestående av de vanligaste delarna och deras olika inställningar för
projektering. I programmet kan man sedan ställa in allt från rörens lutningar, hur
avvattningsbrunnarna ska sitta i förhållande till terrängmodellen och hur delarna ska kopplas
samman. När det gäller beräkningarna är det lätt att ange avrinningskoefficienter och enkelt
att ändra i regn­ och varaktighetsfilen, eller att ladda upp en ny. Att ändra i riktlinjerna är
dock en långdragen process och det är enligt min mening större risk att Storm & Sanitary blir
gammalmodigt och utbytt än att riktlinjerna förändras i någon större bemärkelse.

För att öka förståelsen för hur programmet hanterar dagvatten finns det ett antal delar som bör
studeras vidare. En av dessa är hur koncentrationstider används då man ansätter olika tider till
olika avrinningsområdena och hur koncentrationstiden beräknas för rören. Ett annat intressant
område att studera vidare är hur programmet beräknar infiltrationsmagasin och andra metoder
för lokalt omhändertagande av dagvatten.
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BILAGA 1
För att beräkna de dimensionerande flödena enligt de svenska riktlinjerna används tabeller
liknande den nedan. Tabellen är för det andra området. För att beräkna den sammansatta
avrinningskoefficienten (ϕ tot) används ekvation 2.
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BILAGA 2
För att få tag i rörens dimension utifrån de dimensionerande flödena används excelblad
liknande det nedan där Prandtl­Colebrooks ekvation är inprogrammerad.

I angivna rutor fylls rörets lutning och skrovlighet i samt delflödet från området. Ett första val
av rördimension fylls även i. Värdena i de övriga rutorna beräknas. De mest intressanta
värdena är ”Q full” och ”fyllnadsgrad”. ”Q full” är det flödet som röret maximalt kan ta emot
och då fyllnadsgraden överstiger 90­95 % bör en större dimension väljas.
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BILAGA 3

Handbok för dimensionering av
dagvattenledningar med programmet
Inroads Storm & Sanitary
— — — — — — — — — — — — — — — — — —
Camilla Hansen
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INLEDNING
Storm & Sanitary kan användas för att både beräkna det dimensionerande flödet från en yta
och till att beräkna rörens kapacitet.
Det finns två olika sätt att beräkna det dimensionerande flödet från en avrinningsyta. Det
enklaste sättet och det som i stora delar liknar den svenska beräkningen är den rationella
metoden.

)(dim rtiAQ ⋅⋅= ϕ

Ovan står formeln för den rationella metoden där A står för avrinningsytans area [m2], C är
avrinningskoefficienten och i(tr) [mm/h] står för regnintensiteten beroende av
koncentrationstiden (Time of Concentration).
För att beräkna rörens kapacitet användas Prandtl­Colebrooks ekvation. Ekvationen itererar
fram rörets minsta dimension och dess kapacitet.
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där f är friktionsfaktorn, k är skrovlighetsfaktorn [mm], D är rörets diameter [m], υ är
vattnets viskositet [m2/s] och S0 är rörets lutning.
Den rationella metoden i S&S ger en bra överensstämmelse med de svenska beräkningssättet
enligt VAV P90.
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GRUNDINSTÄLLNINGAR INFÖR PROJEKTERING SAMT
BERÄKNING

Project Defaults
Det första som ska göras i S&S är att skapa en Project Defaults. Detta gör man under
File>Project Defaults i S&S.

Man anger ett Configuration Name som passar och sedan anges de filer som denna
konfiguration automatiskt ska hämta när programmet senare används.

Default Directory Paths anger sökvägarna för projektfilerna.
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Options
Grundinställningarna för projekteringen görs i Options och Drainage Options. Options hittas
under Tools>Options eller . Ändrar man på inställningarna i dessa två menyer kan det vara
bra att i slutet spara sina ändringar under Preferences längst ner i rutorna. Då går det snabbt
att öppna upp (Load) sina egna inställningar varje gång man öppnar programmet.

I Options under fliken Precision görs inställningar som påverkar enheternas värdesiffror.
Under fliken Units and Format ställer man in om man vill ha SI enheter eller amerikanska
enheter samt om man vill ha lutningen i procent, promille, decimaltal etc.

Drainage Options
I Drainage Optionsgörs görs allmänna inställningar som programmet använder sig av för
bland annat beräkningarna. De allmänna inställningarna kompletterar t ex databasen för rör,
brunnar, diken med information om sandfångsdjup, andel effektiv öppning (gallerbrunnar)
osv. De inställningar som visas är de vanligaste inställningarna och finns sparade som
Preferences>dimensionering. Drainage Options hittas under Tools>Drainage>Options eller

.
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Under fliken General ställer man in areaenheter, status på de olika delarna som rör och
brunnar. Vid projektering av befintliga nät bör statusen för rör och brunnar ställas till fixed.
Detta gör att dimensionen inte ändras vid en simulering. Vid simulering av nya nät kan rören
ställas till resize om man vill att programmet ska beräkna rördimensionerna. De övriga
delarna ska vara fixed.

Under fliken Structure IDs ställer man in vilken prefix man vill ha för de olika delarna och
hur programmet ska namnsätta dem när de sätts ut. Delarnas namn går att ändra i senare
skeden.
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Under fliken Pipe ställer man in hur de olika rörtyperna ska se ut. Vilken form (Shape), vilket
system röret ska användas i (Material), och dimension (Size). Skrovlighetsfaktorn
(Roughness) hämtas från strukturdatafilen. Tänk på att den ska anges i millimeter och inte i
meter. Vilken max/min lutning röret ska ha för att uppnå självrensningseffekt finns angivet i
VAV P90. Max och min täckning kan också anges, detta kan vara bra att göra när
programmet ska dimensionera själv eller om man vill ha en felanmälan vid en för liten
täckning.

Flikarna Channel och Culvert används när man har diken eller kulvertar i
avvattningssystemet. Under fliken Design ställer man bland annat in vilken ekvation man vill
använda för beräkning av flödet. För att få det så likt VAV P90 som möjligt används
Darcy/Colebrook. Viskositeten för vatten vid 10°C är 1·10­6 m2/s. Under Bench Type väljer
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man den sorts vallning som brunnarna ska ha. Vid Structure kan man göra specifika
designinställningar för de olika delarna.
För rör ska största och minsta tillåtna dimension väljas samt största och minsta vattenhastighet
i röret. Här kan man alltså förinställa krav från t ex VAV P90 , beställare osv. Depth to Height
Ratios går inte att använda vid dagvattenledningar.

När det gäller brunnar används Curb­inställningarna i stort sett bara då man har vertikala
intagningsöppningar.

Under fliken Area ställer man in vilken metod som ska användas för att beräkna
nederbördsdata, IDF File är det vanligaste. Läs mer under Nederbörd. Vilken återkomsttid för
regn som ska användas i de flesta fall ställer man in under Frequency, detta går att ändra
senare för varje avrinningsområde. Om de flesta avrinningsområden har samma
avrinningskoefficient kan det vara bra att skriva in den här. Annars gör man det enklast vart
område för sig.



34

Under fliken Gutter Section ställer man in hur rännstenen ser ut. Det går antingen att koppla
lutningarna direkt till terrängmodellen eller att uppskatta lutningen. Den transversella
lutningen bestäms av ytan (vid vägavvattningen är det alltså bomberingen på vägen) och den
longitudinella lutningen kan sättas till den lutning som vägen har.

Under fliken Inlet bestämmer man vilken sorts brunn som ska användas, vilken typ och dess
storlek. Vid Clogging ställer man in hur stor del av öppningsytan som är övertäckt och inte
används för ett effektiv omhändertagande av avrinningen. Intercept Flow anger hur pass
mycket av det förbipasserande vattnet som brunnen kan ta emot, denna inställning används
enbart då man vill låta programmet beräkna brunnens dimensioner (resize).
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Än så länge finns inga inställningar under fliken Pump. Under fliken Manhole görs liknande
inställningar som för rör. Man bestämmer vilken sorts nedstigningsbrunn man ska ha
(Material) och dimension (Size). Här kan man även bestämma sandfångsdjup (Depth Below
Invert), hur brunnen ska placeras i förhållande till väglinjen och i vilken vinkel osv.

NEDERBÖRD
Val av återkomsttid (Frequency) för regn görs enligt VAV P90. Om regnet kan avledas från
området via ytan genom självfall inom citybebyggelse (så kallat ej instängt område) sätts
återkomsttiden till 2 år, utanför city till 1 år. Då dagvattnet ej kan avledas från ytan med
självfall (instängt område) sätts återkomsttiden för citybebyggelse till 10 år och utanför
citybebyggelse till 5 år.

Återkomsttid [år]
1 2 5 10 50

Minuter [mm/hr] [mm/hr] [mm/hr] [mm/hr] [mm/hr]
1 177,5 221,5 296,4 375,6 Anv. ej
3   80,6 100,6   134,6 170,6 Anv. ej
5   55,8   69,5   93,6 118,4 165,8
10   37,1   46,4   62,3   93,6 131,0
15   30,2   37,8   50,8   62,3   87,2
20   24,5   30,6   41,4   52,6   73,6
25   20,9   26,3   35,3   44,6   62,5
30   18,4   23,0   29,9   39,2   54,9

Detta är IDF filen för Z=18. Intensiteter för 1, 3 och 5 minuter är beräknade utifrån

cbZaZti r )(78,2),( ⋅+=

där konstanterna a, b och c finns givna i VAV P90. Övriga intensiteter kommer från SMHI.
Sverige är indelade i områden med olika Z­värden, se figur 4.3 i VAV P90. Norra Stockholm
befinner sig i området med Z=18. I en rapport från Svenskt Vatten (nr 2006­26) finns ett nytt
samband för att beräkna intensiteten
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där )( rti  är nederbördsintensiteten [l/s ha], iτ  är regnets återkomsttid [månader] och jt∆  är
regnets varaktighet [min].
Det här sambandet är rikstäckande.

S&S interpolerar värdet på intensiteten över avrinningsområdet beroende på vilken
koncentrationstid som beräknats för det givna området. Därför är det viktigt att filen inte
innehåller några nollor och att de nederbördsvärden som behövs för interpolering för de olika
koncentrationstiderna finns givna.

I de tabeller som används som IDF filer finns en siffra högst upp i vänstra hörnet. Den talar
om för programmet hur många kolumner med intensiteter tabellen innehåller. Om man ändrar
antal kolumner måste även denna siffra ändras för att programmet ska kunna använda
tabellen.
Programmet har ett fel i sig som gör att det inte kan hämta värden med decimaltal från
tabellen.

INSTÄLLNINGAR
Se till att IDF filen finns inlagd i Project Defaults. Återkomsttiden kan dels ställas in
”globalt” under Drainage Options och dels under Drainage>Flows>Compute
Flow>Compute Runoff Coefficient>Rainfall Frequency.

Återkomsttiden kan ändras för flera avrinningsområden samtidigt genom att gå till
Drainage>Flows>Bulk Area Update och lägga in de områden där återkomsttiden behöver
ändras.

YTAVRINNING
Hur mycket vatten som rinner av en yta beror på hur mycket det regnar, vilken typ av yta det
är och hur mycket ytan lutar.

INSTÄLLNINGAR

Skapa ytor
Skapa ett lager där du kan lägga in avrinningsytorna. Områdena ritas upp som polygoner
Tools>Main>Polygons i Microstation. Se till att ytornas brytpunkter ligger i samma plan, dvs
med samma z­värde. Detta kan kontrolleras genom att använda info­knappen i Microstation,
klicka på en yta och gå in på Details i den ruta som öppnas. I Microstation kan man trycka
bort Accu Snap  för att förhindra att programmet ”snappar” till olika höjdkurvor.

Koppla ytor till S&S
För att koppla polygonen till S&S gå till Drainage>Flows>Compute Flows eller .
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Då öppnas den här rutan. Vi använder Modified Rational metoden för att beräkna flödet.
Tryck på ”siktet” och använd det för att trycka på polygonen. Programmet beräknar nu ytans
area.

Avrinningskoefficient
Om ytans avrinningsegenskaper kan beskrivas med endast en avrinningskoefficient skriv in
värdet på den avrinningskoefficienten i fältet (Runoff Coefficient). Om
avrinningsegenskaperna måste beskrivas med hjälp av flera koefficienter gå in på Compute
vid avrinningskoefficientfältet. Då dyker den här rutan upp.

I exemplet består avrinningsområdet av 20% tak, 30% asfalt och 50% park. Benämningarna
av områdena saknar betydelse för beräkningen och kan ändras i runoff.dat filen så att det
passar de egna behoven. Det viktigaste är att INTE använda de nedersta raderna då de inte
fungerar i V8.8 och V8.9 av S&S. Viktigt är också att ange rätt återkomsttid.

Koncentrationstid
Koncentrationstiden (Time of Concentration) går att beräkna för varje område men blir då ofta
väldigt kort då området är litet. Programmet väljer regnintensiteten efter koncentrationstiden
och för korta rinntider blir regnintensiteten väldigt hög. Detta kan ge missvisande resultat om
beräkningarna ska kunna jämföras med VAV P90, därför bör koncentrationstiden sättas till 10
minuter för små avrinningsområden enligt VAV P90.
Vill man beräkna koncentrationstiden för varje område går man in på Compute och anger den
längsta vägen som en droppe vatten kan ta inom området, områdets lutning samt ett värde på
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antingen Kirpich eller FAAs konstant. Kirpich konstant är 0,049 för asfalt och 0,0195 för ej
hårdgjord yta. FAAs konstant är 3,26. Båda konstanter är enhetsberoende, värdena här är
angivna för beräkningar med SI­enheter.

Koppla avrinningsområde till brunn
När koncentrationstiden är angiven är det sista man ska göra att koppla ytan till en brunn.
Detta görs genom att använda siktet vid Attach To. Tryck Apply för att spara.
Avrinningsområden går även att koppla till fria inlopp, dike (kanaler) och kulvertar men inte
till nedstigningsbrunnar.

Queries
En bra funktion där en mängd olika saker kan ändras samtidigt. Välj vilken typ som ska
ändras, tryck på Modify Attributes och välj hur typen ska ändras tryck Add och Apply.

DIMENSIONERING
Dimensionera gör man genom att gå till Drainage>Network>Design eller . Följande ruta
kommer då upp.

Genom att ta siktet och trycka på det nedersta röret i ledningsnätet simuleras hela systemet
uppströms den brunnen. De två av rutorna som är ikryssade i bilden måste vara ikryssade för
att få ett resultat som liknar beräkningar med VAV P90. Den första rutan gör att man får en
resultatfil och den fjärde att brunnarna som områdena är kopplade till måste ta emot allt vatten
som kommer till dem. Om inte den fjärde rutan är ikryssad beräknas dagvattenbrunnarnas
kapacitet att ta emot vatten genom gallret och begränsas även av hur stor andel av flödet som
den kan ta emot enligt inställningarna under Inlet. Den höga detaljeringsgraden behövs inte
för de flesta beräkningar. Är intagskapaciteten lägre än det flöde som rinner till brunnen
fortsätter flödet till nästa brunn och man får inte med sig hela flödet i beräkningen. Den andra
rutan kan vara intressant att kryssa i och ha som jämförelse. Enable Time of Concentration
betyder att programmet beräknar koncentrationstiden för vattnet i rören. Det gör att
simuleringen blir mer verklighetstrogen. VAV P90 kan dock inte ta hänsyn till rörens
koncentrationstid och därför blir flöden beräknade med andra rutan ikryssad lägre än flöden
enligt VAV P90.
För att det ska gå att utföra dimensioneringsberäkningen krävs det att alla inställningar är
korrekta. Programmet ger ett felmeddelande som anger vad som saknas för att beräkningen
ska kunna genomföras.
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VANLIGA PROBLEM
En av brunnarna saknar flöde
Gå till Drainage>Flows>Inject flow eller  och injicera ett litet flöde 0,0001 m3/s.

En av brunnarna saknar lutning
Tryck Edit/Review på brunnen och gå sedan till fliken Gutter. Den transversella lutningen
bestäms av ytan (vid vägavvattningen är det alltså bomberingen på vägen) och den
longitudinella lutningen kan sättas till den lutning som vägen har. Saknas väglutningen görs
en uppskattning av denna.

Gutter Flow och Peak Flow är olika
Kontrollera återkomsttiden under nederbörd och inställningar.

Rören är resize istället för fixed
Gå till Tools>Drainage>Queries eller . Välj Structure type till rör. Välj sedan Modify
Attributes, sätt Status = fixed, tryck Add och Apply. På detta sätt kan även en mängd andra
saker ändras.

RESULTAT
När simuleringen är slutförd kommer resultatfilen upp i ett eget fönster. Beroende på vilka
rutor man kryssat i ser resultatfilen lite olika ut.

Under inlet kan man se att Bypass eller Capacity är noll då ”Capture all flow” rutan är
ikryssad. Även koncentrationstiden beräknas för de olika delarna då Enable Time of
Concentration är ikryssad för den här simuleringen.

Under pipe kan man se vilken status, dimension, kapacitet mm röret har. Rörets Total Flow
stämmer väl överens med det flöde som beräkningar enligt VAV P90 skulle ha gett.
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